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Adobe Photoshop CS3 คืออะไร 
 Adobe Photoshop CS3 เปนโปรแกรมคอมพิวเตอรที่รวบรวมเครื่องมือสําหรับตกแตงภาพประสิทธิภาพสูง 
เพื่อการทํางานระดับมาตรฐานสําหรับนักออกแบบมืออาชพีที่ตองการสรางสรรคงานกราฟกที่โดดเดน ทั้งงานที่ใชบน
เว็บและงานสิ่งพิมพ 
 

ความละเอียดของภาพกราฟก 
    ภาพที่ปรากฏบนหนาจอคอมพิวเตอรนัน้ เกิดจากจุดสี่เหล่ียมเล็กๆ ของสีที่เราเรียกวา พิกเซล (Pixel)  (พิก
เซลเปนองคประกอบที่เล็กทีสุ่ดของภาพ) มาประกอบกันเปนภาพขนาดตางๆ  
  ความละเอียดของภาพจะมีหนวยวัดปน พกิเซล/ตารางนิ้ว และงานกราฟกในแตละแบบก็จะใชความละเอียดที่
แตกตางกัน ดงันี ้

• ภาพที่แสดงบนหนาจอคอมพิวเตอร เชน หนาเว็บ หรืองานพรีเซนเตชัน่ ใชความละเอียด 72 พิกเซล/
ตารางนิ้ว 

• ภาพถายทั่วๆไป ใชความละเอียด 150 พิกเซล/ตารางนิ้ว 

• ภาพในงานพิมพ ใชความละเอียด  300 พิกเซล/ตารางนิ้ว 
 

พื้นที่การทํางาน (Work Area) 
 Work Area หรือพืน้ที่การทํางานของโปรแกรม Adobe Photoshop จะประกอบดวยเครือ่งมือสําหรับการ
ตกแตงไฟลภาพตาง ๆ ดังนี้  

1. Menu bar คือสวนที่แสดงชื่อเมนูตางๆ ของโปรแกรม ก็จะประกอบดวย 
 File , Edit , Image , Layer , Select  ,  Filter , View  , Window  , Help   

  1.1 File หมายถึง คําสั่งเกี่ยวกับการจัดเก็บและเรียกใชไฟลรูปภาพตางๆ  
  1.2 Edit หมายถึง คําสั่งเกี่ยวกับการแกไขลักษณะของรปูภาพและ Image ตางๆ  
  1.3 Image หมายถึง คําสั่งการจัดการรูปภาพและ Image ตางเชน การเปลี่ยนสีและการ   
        เปลี่ยนขนาด  
  1.4 Layer หมายถึง ชั้นหรือลําดับของรูปภาพและวัตถุที่เราตองการจะทํา Effects  
  1.5 Select  เปนคําสั่งการเลือกพื้นที่หรือสวนตางของรูปภาพและวัตถุในการที่จะเลน Effects  
         ตางๆ  
  1.6 Filter เปนคําสั่งการเลน Effects ตางๆสําหรับรูปภาพและวัตถุ  
  1.7 View เปนคําสั่งเกี่ยวกับมุมมองของภาพและวัตถุในลกัษณะตางๆ เชน การขยายภาพ 
         และยอภาพใหดูเล็ก  
  1.8 Window  เปนสวนคําสั่งในการเลือกใชอปุกรณเสริมตางๆที่จําเปนในการใชสราง Effects  
         ตางๆ  
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  1.9 Help เปนคําสั่งเพื่อแนะนําเกี่ยวกับการใชโปรแกรมฯและจะมีลายละเอียดของโปรแกรม  
        อยูในนัน้ 

2. Toolbox คือสวนของอุปกรณตาง ๆ ที่ใชในการสรางชิ้นงานหรือตกแตงภาพ 
3. Tool options bar คือสวนที่กําหนดคุณสมบัติของอุปกรณที่เลือกจาก Toolbox 
4. Palettes คือสวนที่ใชตรวจสอบและกําหนดคุณสมบัติตาง ๆ ใหกับรูปภาพ 
5. Status bar คือสวนที่แสดงรายละเอียดตาง ๆ ของชิ้นงาน เชน ขนาดของมุมมองรูปภาพ ขนาดของไฟล 

คําแนะนําการใชงานของอุปกรณที่เลือกจาก Toolbox 
 

Tool options bar 

Work area 

Menu bar 

Toolbox 

Palettes 
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เคร่ืองมือตางๆ (Toolbox) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
หมายเหตุ ปุม Toolbar ที่มีเครื่องหมายสามเหลี่ยมเล็กๆ อยูดานลางขวาเมื่อกดปุมสามเหลี่ยมดังกลาว โปรแกรมจะ

แสดงเครื่องมืออื่นๆ ออกมาเชน   
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อธิบาย Tool ตางๆ 

 
Marquee Tool
เปนการเลือกแบบสี่เหลี่ยมผืนผา, วงกลม, แถวขนาด 1 พกิเซลส หรือคอลัมน 1 พิกเซลส  

 
Move Tool  
ใชเพื่อเลื่อนสวนที่เลือก หรอืไวเล่ือน Layer และ Guide ตางๆ 

 

Lasso Tool
จะใชเพื่อสราง Selection แบบอิสระ, แบบ Polygonal (ตามจุดที่คลิก) และ Magnetic (ดึงเขาหาขอบ
รูปภาพ) 

 
Magic Wand Tool  
ใชเลือกพื้นที่บริเวณที่มีสีเดียวกัน 

 
Crop Tool  
ใชในการเลือกบางสวนของรปูภาพ 

 
Slice Tool
ใชในการสราง Slice 

 
Slice Selection Tool
ใชเลือก Slice ที่คุณสรางขึ้นมา 

 
Healing Brush Tool 
ใชในการระบายสี เพื่อซอมแซมรูปภาพใหสมบูรณแบบ 

 

Patch Tool 
ใชเฉพาะในบรเิวณที่เลือกไวเทานั้น เพือ่ใหเกิดความสมบูรณของรูปภาพ โดยใชลวดลาย หรือใชสวนที่เลือก
ในภาพเปนตนฉบับ 

 
Brush Tool  
ใชในการวาดเสน Brush ตางๆ 

 
Pencil Tool  
ใชในการวาดเสนที่มีขอบชัดเจน 

 
Clone Stamp Tool 
ใชก็อปปรูปโดยอาศัยรูปภาพตนฉบับ 

 
Pattern Stamp Tool  
ใชเพื่อวาดรูปโดยใชบางสวนของรูปภาพที่มอียูเปนตนฉบบั 

 
History Brush Tool   
ใชกลับคืนรูปภาพเดิมจาก State หรือ Snapshot ของรูปเดียวกัน 

 

Art History Brush Tool 
ใชในการวาดรูป จาก State หรือ Snapshot ของรูปนี้โดยอาศัยรูปแบบของ Stoke ที่มีสไตลหลากหลาย ชวย
ใหสไตล ของภาพดูตางออกไป 
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Eraser Tool  
ใชลบรูปภาพหรือลบบางสวนของพิกเซลสและทําการเก็บสวนตางๆ เปน State ตางๆ ใน History Palette 

 
Magic Eraser Tool  
ใชลบรูปภาพบริเวณที่มีสีเดียวกันใหกลายเปนพื้นทีโ่ปรงใส (Transparent) โดยการคลกิเพียงครัง้เดียว 

 
Background Eraser Tool 
ใชลบรูปภาพบางสวนใหกลายเปนพื้นทีโ่ปรงใสโดยการลากเมาส 

 
Gradient Tools 
ใชเพื่อไลสีระหวางสีหลายๆ สี ในแบบตางๆ Straight-line,  Radial, Angle, Reflected และ Diamond 

 
Paint Bucket Tool  
ใชในการเติมสี Fill ในบริเวณที่เปนสีเดียวกันดวยสีของ Foreground 

 
Burn Tool  
ใชลดความสวางทําใหรูปภาพดูมืดลง

 
Sponge Tool  
ใชเปลี่ยนสีในสวนตางๆ ของรูปภาพ โดยการปรับคาความเขมสี

 
Path Selection Tool
ใชเพื่อเลือก Shape หรือ Path เพื่อแสดง Anchor Paint, Direction Line และ Direction Paint  

 
Type Tool  
ใชในการสรางตัวหนังสือลงบนรูปภาพ 

 
Type Mask Tool 
ใชสราง Selection เปนรูปรางตัวหนังสือ 

 
Pen Tools
ใชในการลากเสน Path ซึ่งสามารถดัดโคงตามรูปภาพได 

 
Custom Shape Tool
ใชเลือกรูปภาพเลือกรูปภาพที่มีรูปรางเฉพาะจาก Custom Shape List 

 
Animations Tool
ใชเขียนโนต หรือแนบเสียงไปกับรูปภาพได 

 
Eyedropper Tool  
ใชในการดูดสีจากรูปภาพเพื่อใชเปนตนแบบของสีกับงานชิน้อื่นๆ 

 
Measure Tool
ใชวัดระยะหาง, ตําแหนงและมุมองศาระหวางภาพ 

 
Hand Tool  
ใชเล่ือนภาพที่อยูในหนาตางเดียวกัน 

 
Zoom Tool  
ใชในการขยายและยอสวนการแสดงภาพบนหนาจอ 
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การเปดไฟลภาพ (Open) 
 

1. คลิกที่เมนูคําสั่ง File ที่แถบ Menu bar จากนั้นเลือกคําสั่ง Open 

 
 

2. จะปรากฏ Dialog แสดงรายชือ่ไฟลตาง ๆ ดังภาพ เพื่อเลือกไฟลที่ตองการเปดมาใชงาน 

 
 

3. คลิกเลือกไฟลที่ตองการเปดใชงาน จากนัน้คลิกปุม Open 
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การสรางไฟลใหม (New) 
 

1. คลิกที่เมนูคําสั่ง File ที่แถบ Menu bar จากนั้นเลือกคําสั่ง New 
 

 
 

2. จะปรากฏ Dialog สําหรับกําหนดคุณสมบัติตาง ๆ ของไฟลภาพดังนี้ 
 

 
 

- Name คือ ชือ่ของชิน้งาน สามารถกําหนดใหมเองได ชื่อนีจ้ะไประบุที่ชื่อไฟลตอไป 
- Preset คือ ขนาดงานที่โปรแกรมกําหนดมาให ซึ่งมหีลากหลายขนาดใหเลือก หรือสามารถ

กําหนดเองจากชอง Width และ Height ได 
- Width คือ ขนาดความกวางของงาน (จากซายไปขวา) โดยกําหนดหนวยและขนาดไดเอง 

จากรูป คือ 1024 Pixels 
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- Height คือ ขนาดความกวางของงาน (จากบนลงลาง) โดยกําหนดหนวยและขนาดไดเอง 
จากรูป คือ 768 Pixels 

- Resolution คือ ความละเอียดของภาพ โดยใสตัวเลขคาความละเอียดของภาพ เชน งาน
เว็บหรือรูปที่แสดงบนคอมพวิเตอรเทากับ 72 pixels/inch งานสิ่งพิมพเทากับ 150-200 pixels/inch 

- Color Mode คือ โหมดสีของภาพ ซึ่งประกอบไปดวย โหมดสี Bitmap, Grayscale,  
RGB Color, CMYK Color, Lab Color  

- Background Contents คือ สีพื้นหลังของภาพ เม่ือเริ่มชิน้งานใหม มีดังนี ้

• White กําหนดใหสีพื้นหลงัเปนสีขาว 

• Background Color กําหนดใหสีพื้นหลงัเปนสีเดียวกับ Background 

• Transparent ไมมีพื้นหลัง 
 

3. หลังจากกําหนดคุณสมบัติตาง ๆ ใหคลิกปุม OK เพื่อเริ่มชิน้งานใหม 
 

การบันทึกขอมูลลงบนไฟล (Save) 
 

 หลังจากตกแตงไฟลภาพเรียบรอย จะตองเก็บบันทึกขอมลูลงบนไฟล (Save) สําหรับการเรียกใชงานในครัง้
ตอไป โปรแกรมมีการบันทึกขอมูลลงบนไฟล (Save) อยู 3 ลักษณะ คือ  

- Save บันทึกไฟลในรูปแบบ (Format) ปกติ ซึ่งจะอยูในรูปแบบ (Format) ของ PSD 
- Save As บันทึกไฟลในรูปแบบ (Format) อื่น ๆ ได เชน JPEG, BMP, GIF เปนตน 
- Save for Web บันทึกไฟลในรูปแบบ (Format) สําหรับการใชงานบนเว็บ เชน ไฟล 

Html และไฟลรูปภาพ JPEG, GIF, PGN เปนตน 
ในที่นี่เปนแสดงการใชงานของ Save และ Save As 

1. คลิกที่เมนูคําสั่ง File ที่แถบ Menu bar จากนั้นเลือกคําสั่ง Save หรอื Save As  หรือ Save for 
Web & Devices 
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2. จะปรากฏ Dialog สําหรับกําหนดคุณสมบัติตาง ๆ ของไฟลภาพดังนี้ 
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- ชื่อไฟล (File Name) 
- รูปแบบของไฟล (Format) 
- กําหนดคุณสมบัติของการบันทึกไฟล (Save Options) 

• As a Copy บันทึกไฟลเปนชือ่อื่น รูปแบบ (Format) อื่น ขณะที่ไฟลเดิมกําลังเปดใช
งาน 

• Layers จะเก็บคุณสมบัติของ Layer ตาง ๆ  

• Use Proof setup เก็บคาโหมดสีที่จะใชแสดงสีของภาพกอนจะพิมพ 

• Thumbnail กําหนดใหไฟลทีบ่ันทึก (Save) สามารถแสดงภาพตัวอยางใน Dialog ของ
การเปดไฟล 

• Use Lower Case Extension กําหนดใหนามสกุลไฟลเปนอักษรตัวเล็ก 
3. หลังจากกําหนดคุณสมบัติตาง ๆ ใหคลิกปุม Save เพื่อบันทึกขอมูลลงบนไฟล 

 

การใชงาน Palettes 
 

 Palettes คือ Dialog ที่ใชตรวจสอบและกําหนดคุณสมบัติตาง ๆ ของรูปภาพ เชน Palette ของ Navigator 
และ Info, Palette ของ Color, Swatches เปนตน  

Palette ตาง ๆ จะถูกจัดเปนกลุม ๆ สําหรบัการซอนหรอืแสดง Palettes นั้นใหคลิกที่เมนูคําสั่ง Window 
จากนั้นเลือก Palette ที่ตองการซอนหรอืแสดง Palette ใดถูกเปดใชงานอยูจะมีเครือ่งหมายถูก 
หนา Palette  
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Navigator Palette 
 Navigator Palette เปน Palette ที่ใชสําหรับเปล่ียนขนาดมุมมอง ที่จอภาพตามความเหมาะสม 

ประกอบดวยสวนตาง ๆ ดังนี ้
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Zoom Slider 

Zoom In Zoom Out  

ตัวเลขเปอรเซ็นตของภาพ 

Proxy Preview 
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1. Proxy Preview Area คือสวนที่แสดงถงึขนาดของภาพในชิ้นงาน กรอบสีหมายถึงขนาดของชิ้นงาน หาก

กรอบของ Proxy Preview อยูริมสุดของภาพแสดงวาภาพนั้นมีขนาดพอดีกับชิ้นงาน 
2. ตัวเลขเปอรเซน็ตของภาพ คอืสวนที่ใชกําหนดขนาดมุมมองของภาพ ซึง่อยูในรูปแบบของเปอรเซ็นต 

โดยคาของขนาดภาพจริงจะเทากับ 100 เปอรเซน็ต 
3. Zoom Out & Zoom In คือสวนที่ใชกําหนดขนาดมุมมองของภาพ ประกอบดวยสวนที่ใชกําหนด 3 สวน 

คือ 
3.1 Zoom Out คือสวนที่อยูดานซายสุด ใชสําหรับยอขนาดมุมมองของภาพใหเล็กลง 
3.2 Zoom In คือสวนที่อยูดานซายสุด ใชสําหรับขยายขนาดมุมมองของภาพใหใหญขึ้น 
3.3 Zoom Slider คือสวนที่เปนแถบเลื่อน หากเลื่อนทางดานซายจะยอขนาดมุมมองของภาพใหเล็กลง 

แตหากเลื่อนมาทางขวาจะขยายขนาดมุมมองของภาพใหใหญขึน้ 
 
Color Palette 
 Color Palette คือ Palette ที่ทําหนาที่เปนจานสี ซึ่ง Mode สีที่ปรากฏในภาพจะเปนลักษณะการผสม
ใน Mode RGB มีสวนประกอบตาง ๆ ดังนี ้

1. Set foreground color คือสวนแสดงสีของ foreground 
2. Set background color คือสวนแสดงสีของ background 
3. RGB slider คือสวนที่ใชกําหนดคาของการผสมสีใน Mode RGB ซึ่งสามารถเลื่อนเพื่อปรับคาสี

ไดจากแถบ slide หรือระบุเปนตัวเลข (0-255) เชน สีดํา คอื R=0,G=0, B=0 
4. Sample color คือสวนสําหรับกําหนดคาสีในลักษณะจุมเลือกสี 
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 Sample color 

RGB slider Set background color 
Set foreground color 

Swatches Palette 
  Swatches Palette คือ Palette ที่ทําหนาที่สําหรับเก็บสีหลกัๆ ที่นิยมใช สามารถเลือกนํามาใชได
ทันทีและถาหากวาคุณมีสีที่ตองการใชเปนประจํา สามารถบันทึกสีนั้นไวใน Palette นี้ได  

การบันทึกสีที่ตองการไวที่ Swatches Palette สามารถทําไดโดยเลือกสีที่ตองการ จากนั้นคลิกเมาสที่
ปุมบันทึกสีใหมที่ Swatches Palette จะสามารถบันทึกสทีี่ตองการได 
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ลบสีที่มีอยู 

บันทึกสีใหม 

สีหลักๆ ที่ใชเปนประจํา 

 
Styles Palette 
  Styles Palette คือ Palette ที่มีไวสําหรับเก็บลวดลายอยางลวดเร็ว สามารถเลือกลวดลายจาก 
Palette นี้ไปใชในภาพ จะทําใหภาพที่คุณวาดไวเปลี่ยนไปตามลวดลายที่เลือกไวทันท ีและยังสามารถสราง
ลวดลายใหขึ้นมาเองไดดวย 

การใชงานนั้นสามารถทําไดโดยเลือกที่ Layer ที่ตองการจะทํา Style แลวคลิกเลือกที่ Style บน 
Styles Palette จากนั้น Layer จะเปลี่ยนตาม Style นั้นๆ 
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ลวดลายตางๆ 

Clear Style 

New Style 

Delete Style 
 
History Palette 
 
   เปน Palette ที่แสดงขั้นตอนวิธีการตาง ๆ ทีใ่ชทํางานกับไฟลภาพตามลําดับโดยสามารถยอนกลับ
ไปยังการทํางานตาง ๆ ในลําดับชั้นและยกเลิกได ประกอบดวยสวนตาง ๆ ดังนี ้

 1. สวนที่ใชกําหนดขอมูลของการใช History Brush Tool 
 2. เปนภาพที่แสดงรายละเอียดของงานที่ทําตามลําดับ 
 3. History State เปนลําดับขั้นตอนวิธีการตาง ๆ ที่ไดกระทําลงไป 
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 4. New Document คือสวนที่ใชสรางกระดาษทําการใหม โดยคัดลอกภาพจากลําดับที่ชี้อยู 
 5. New Snapshot คือสวนทีใ่ชสราง Snapshot ใหม 
 6. Trash Button คือสวนที่ใชลบขั้นตอนการทํางานกับไฟลภาพในลําดับที่เลือกอยูออก 
 
 

 
 1 2  
 

3 
 
 
 
 4 5 6 
Layer Palette 

 Layer Palette เปน Palette ที่เก็บชิ้นงานหรือภาพทั้งหมด เรียกวา Layer ซึ่งจะเรียงลาํดับกอนหลัง 
ทําใหเกิดความสะดวกในการจัดการแกไขโดยไมเกิดผลกระทบกับชิ้นงานหรือภาพอื่น ๆ โดยจะแกไขเฉพาะ
ชิ้นงานหรือภาพใน Layer ที่เลือกเทานั้น สวนประกอบของ Layer Palette มีดังนี้ 
1. Indicates Layer Visibility  คอืสวนที่กําหนดการแสดงผลของ Layer หากมีสัญลักษณรูปตาแสดงวาภาพ

ที่อยูใน Layer ดังกลาวถูกแสดงบน Work Area หากไมมีแสดงวา Layer นั้นถูกซอนหรอืไมแสดงผล 
2. Indicates if Layer is Linked คือสวนที่แสดงวา Layer ใดกําลังถูกทํางาน Layer นั้น จะมีสัญลักษณรูป

พูกัน นอกจากนี้ยังสามารถกาํหนดให Layer อื่นเลื่อนตําแหนงตาม Layer ที่กําลังทํางานอยูไดโดยการ
คลิกให Layer อื่นเปลี่ยนเปนสัญลักษณรูปโซ 

3. Add a Layer Style คือสวนที่ใชใส Effect เชน แสง เงา ตาง ๆ ใหกับภาพใน Layer 
4. Add a mask คือสวนที่ใชเพิม่ Mask หรอืเพิ่ม 1 Layer ซอนทับ Layer ที่กําลังทํางานอยู โดยทั้ง 2 จะถือ

เปน Layer เดียวกัน 
5. Create a new set คือสวนที่ใชสราง Folder สําหรับเก็บ Layer ตาง ๆ เขาดวยกัน 
6. Create new fill or adjustment layer คือสวนที่ใชปรับคาสี ความคมชัด แสงและความสวางในแบบตาง ๆ 

ของภาพใน Layer 
7. Create a new layer คือสวนที่ใชสราง Layer ใหม 
8. Delete layer คือสวนที่ใชลบ Layer 
9. Layer Thumbnail คือสวนที่แสดงวา Layer นั้นมีภาพใดอยู 
10. Lock คือสวนทีใ่ช Lock ในรูปแบบตางๆ 
11. Opacity คือสวนที่ใชทําให Layer นั้นโปรงใส  (ทั้ง Fill และ Effect) 
12. Fill คือสวนที่ใชทําให เฉพาะ Fill ใน Layer นั้นโปรงใส ซึ่งไมรวม Effect ที่ Layer นั้นมอียู 
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หมายเหตุ:  แถบสีน้ําเงินแสดงวากําลังทํางานกับ Layer 2  

การจัดลําดับ Layer สามารถทําไดโดยนําเมาสคลิกคางไวที่ Layer แลวลากไปยังตําแหนง
ที่ตองการ หรือใชเมนูคําสั่ง Layer -> Arrange 

• Bring to Front คือ สง Layer ไปยังตําแหนงบนสุดของทกุ Layer 

• Bring Forward คือ สง Layer ขึ้นไปตําแหนงบน 1 ขั้น 

• Send Backward คือ สง Layer ลงไปตําแหนงลาง 1 ขั้น 

• Send to Back คือ สง Layer ลงไปตําแหนงลางสุดของทุก Layer แตยกเวน 
Background Layer 

 

การกําหนดพื้นที่ เพื่อแกไขและตกแตงภาพ (Selection) 
 

Marquee Tool เปนเครื่องมือสําหรับการกําหนด Selection โดยคลิกเลือก Marquee Tool จาก Tool box จะมี
ใหเลือกใชงาน 4 รูปแบบตามความเหมาะสม

 Rectangular Marquee Tool  
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สําหรับการสราง Selectionเปนสี่เหลี่ยมผืนผา และสี่เหล่ียมจัตุรัส

 Elliptical Marquee Tool  
สําหรับการสราง Selection เปนวงกลมและวงรี

 Single Marquee Tool  
สําหรับการสราง Selection เปนพื้นทีรู่ปเสนตรงในแนวนอน ความกวาง 
1 pixel 

 Single Column Marquee Tool  
สําหรับการสราง Selection เปนพื้นทีรู่ปเสนตรงในแนวตัง้ ความกวาง  
1 pixel  
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วิธีการใชงาน Marquee Tool 
 
1. ใหคลิกที่ Marquee Tool บน Tool Box หรือหากตองการเลือกรูปแบบอื่นของ Marquee Tool ให

คลิกเมาสคางไว แลวคลิกเลือกรูปแบบที่ตองการสราง Selection 
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2. วางตําแหน ของ Cursor  รูป เพื่อกําหนดจุดเริ่มสําหรับการสราง Selection 
3. ใหคลิกเมาสคางไวและลากเพื่อกําหนดขนาดของพื้นที่ทีต่องการ แลวปลอยเมาส จะปรากฏเสนประ

ของ Selection ดังภาพ 

               
 
Marquee options 

เม่ือคลิกเลือกใชงาน Marquee Tool ที่ Tool options bar เราจะสามารถกําหนดคุณสมบัติตาง ๆ ของ 
Marquee tool ไดดังนี ้

 
 
 

Width Height Style การแกไข Selection 

Feather 

 
1. การแกไข Selection จะมีใหเลือก 4 รูปแบบคือการกําหนดเลือก Selection ใหม การเพิม่ ตัดและลด 

Selection และการสราง Selection ดวยวิธีการตางๆ ดังนี ้
เม่ือคลิกเมาสจะเปนการสราง Selection ขึ้นใหม 
สราง Selection เพิ่มขึ้น โดยพื้นที่ Selection กอนหนาจะไมหายไป แตจะถูกรวมเขาดวยกัน 
ลบพื้นที่ของ Selection ออกจาก Selection กอนหนา 
เปนการสราง Selection ใหมในพื้นที ่Selection เดิม ดวยวิธี Intersect จากพื้นที่ Selection ที่กําหนด
ใหมและ Selection กอนหนา ที่มีพื้นที่เดียวกัน 

2. Feather กําหนดความฟุงเบลอของขอบ Selection ภาพ มีคาตั้งแต 1 – 250 หากกําหนดคามากความฟุง
เบลอจะมากตาม 

3. Style ของ Marquee Options มี 3 รูปแบบคือ 
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• Normal เลือกขนาดอิสระ ขนาดของ Selection จะเปลี่ยนไปตามการเคลื่อนตําแหนงเมาส 

• Constrained Aspect Ratio  กําหนดขนาดของ Selection โดยยืดหยุนตามอัตราสวนของความ
กวาง (Width) และความสูง (Height) 

• Fixed Size กําหนดขนาดของ Selection ตามอัตราสวนของความกวาง (Width) และความสูง 
(Height) ที่แนนอน       

4. Width การกําหนดความกวางของ Selection 
5. Height การกําหนดความสูงของ Selection 

 

การสราง Fixed Size Selection  
 
ถาตองการสราง Selection ขนาดกวาง 600 ยาว  80 Pixels ใหเปลี่ยนชอง Style เปนแบบ Fixed 

Size และกําหนดความกวางและความยาวตามที่ตองการ  
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                                                                                 เปลี่ยนเปน Fixed Size           ระบุขนาด กวาง 

และยาว 

Lasso Tool 
  
เปนเครื่องมือที่สามารถสราง Selection ไดอยางอิสระ มีความยืดหยุนสูง เม่ือคลิก Lasso Tool ที่ 

Tool bar จะมีใหเลือกทั้งหมด 3 รูปแบบดังนี ้
1. Lasso Tool 

  เปนการสราง Selection อยางอิสระ วิธีการใชงานเมื่อคลกิเมาสคางแลวลากไปตามขอบของพืน้ที่ 
Selection ที่ตองการ จนมาบรรจบที่จุดเริ่มตนแลวจึงปลอยเมาสจะปรากฏเสนประของ Selection สามารถ
กําหนดคุณสมบัติของ Lasso Tool ตาง ๆ ไดดังนี้ 
 
 

1 2 
 

 

• Feather กําหนดความฟุงเบลอของขอบพืน้ที่ Selection 

• Anti-aliased กําหนดใหขอบของพืน้ที่ที่เลือกมีความเรียบยิ่งขึ้น ไมขรุขระ 
 

2. Polygonal Lasso Tool 
 เปนการสรางพืน้ที่ของ Selection ในลักษณะของรูปหลายเหล่ียม คลิกเมาสบนภาพเพื่อกําหนด
จุดเริ่มตนในครั้งแรกแลว ลากเมาสจะปรากฏเสนตอจากจุดเริ่มตนกับปลายเมาส วิธีการใชงานเมื่อคลกิเมาส
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Selection ที่เปนเสนตรงเชื่อมจากจุดตนมายังจุดปลายเมาสที่คลิก ใหทําแบบนี้เรื่อย 
ๆ เพื่อสรางเสนขอบของ Selection จนสุดทายใหคลิกเมาสบรรจบที่จุดเริ่มตนครั้งแรก จะเกิด Selection ขึ้น 
สําหรับการกําหนดคุณสมบัติจะเหมือนกับ Lasso Tool 
 

3. Magnetic Lasso Tool 
เปนการสรางพื้นที่ของ Selection อยางอสิระและรวดเรว็ในลักษณะของแมเหล็กที่ดูดเขาหาสี โดย 

Magnetic Lasso Tool จะใชความแตกตางระหวางสีที่เลือกกับสีของ Background เปนตัวกําหนดขอบเขต
พื้นที่ Selection วิธีการใชงานเมื่อคลิกเมาสเพื่อกําหนดจดุเริ่มตนแลว ใหปลอยเมาสแลวลากเมาสตาม
ขอบเขตพื้นทีท่ี่ตองการเลือก Magnetic Lasso Tool จะเลือกขอบเขตพืน้ที่ Selection เองโดยอัตโนมัติ จน
สุดทายใหคลิกเมาสบรรจบที่จุดเริ่มตนครัง้แรก จะเกิด Selection ขึ้น คณุสมบัติของ Magnetic Lasso Tool 
มีเพิ่มจาก Lasso Tool ไดดังนี ้

 

 
 

1 2 3  
1. Width มีคาตั้งแต 1-40 pixels เปนการกําหนดใหโปรแกรมทําการตรวจสอบหาขอบเขตของพื้นที่ที่เลือก 

นับต้ังแตจุดที่เมาสชี้อยูไป X pixels เพื่อกําหนดขอบเขต 
2. Edge Contrast มีคาตั้งแต 0-100% หากมีคามากจะทําใหเสนขอบของพื้นที่ที่เลือกอยูระหวางสีที่

Contrast กันมาก 
3. Frequency มคีาตั้งแต 0-100 pixels หากคาความถี่มากจะทําใหมีการกําหนดจุดในแตละชวงของการ

เลือกมาก ทําใหโปรแกรมสามารถเลือกพืน้ที่อยางมีความถูกตองมากขึ้น 
 

Magic Wand Tool 
 

 กําหนดพื้นที่ของ Selection โดยเลือกบริเวณที่มีคาสีใกลเคียงกัน วิธีการใชงานคือคลิกที่ปุม  
บน Tool box แลวคลิกเลือกพื้นที่ที่ตองการสราง Selection นอกจากนี้แลวยังสามารถกําหนดคุณสมบัติของ 
Magic Wand Tool ไดดังนี ้

 
 

1 2 3 4 

 
 

 
1. Tolerance มีคาใหกําหนดตั้งแต 0 – 255 pixels เปนคาของจํานวนสีที่ใกลเคียงกับสีที่ถูกเลือก 
2. Anti-aliased กําหนดใหขอบของพื้นที่ที่เลือกมีความเรียบยิ่งขึ้น ไมขรุขระ 
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3. Contiguous สามารถทําการเลือกบริเวณสีที่ใกลเคียงกันไดเฉพาะในกลุม pixels ที่ไดคลิกเลือกเทานั้น ถา
ไมได Check ไวจะเลือกบริเวณที่มีสีใกลเคียงกันในภาพทัง้หมด 

4. Use All Layers เลือกสีโดยมองทุก Layer เปนเหมือน Layer เดียว หากไมถูก Check ไว หมายถึงใช 
Magic Wand Tool เฉพาะ Layer นั้นเทานัน้ 

 

Crop Tool 
 

กําหนดพื้นที่ของ Selection โดยตัดสวนที่เหลือที่ไมไดอยูในพื้นที่ของ Selection 
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ในภาพทิ้งไป 
วิธีการใชงานคือคลิกที่ปุม           บน Tool box แลวคลิกเมาสคางไวจากนั้นลากเมาสเพื่อกําหนดพืน้ที่ของ 
Selection แลวจึงปลอยเมาส เม่ือพรอมที่จะตัดสวนที่เหลือออก ใหคลิก ปุม           บน Tool 
options bar   หรือ ปุม เพื่อยกเลิก นอกจากนี้เรายังสามารถกําหนดคุณสมบัติตาง ๆ ของการตัด
ดังนี ้

 
 
 
 

1. Cropped Area เลือกผลลพัธของภาพที่ตัด 
1 2 4 5 3 

• Delete ตัดภาพโดยลบสวนที่เหลือออก 

• Hide ตัดภาพ โดยซอนสวนทีเ่หลือเอาไว 
2. Shield cropped area แสดงสีบนพื้นที่สวนทีเ่หลือที่จะถูกตดัออก 
3. Color สีที่จะแสดงบนพื้นที่สวนที่เหลือ 
4. Opacity คาความโปรงแสงของสีบนพื้นที่สวนที่เหลือ 
5. Perspective ปรับพื้นที่การตัดใหไดภาพที่มีมิติ 

 

คําสั่งพืน้ฐานของ Selection 
 

• All กําหนดพืน้ที่ Selection โดยใชพื้นที่ของรูปภาพทั้งหมด 

• Deselect ยกเลิกการกําหนดพื้นที่ Selection 

• Reselect ยอนกลับไปกําหนดพื้นที ่Selection หลังจากไดยกเลิกไป 

• Inverse เปนการเปลี่ยนพื้นทีข่อง Selection จากที่กําหนดไวใหเปน
พื้นที่ตรงขาม 
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การใช Transform เพือ่ปรับเปลี่ยนพื้นที่ Selection  
 

คลิกที่เมนูคําสั่ง Edit ที่แถบ Menu bar จากนั้นเลือกคําสั่ง Transform 
- Again กลับสูรปูแบบเดิมกอนหนานี ้1 ขั้น 
- Scale ปรับเปลี่ยนแบบ Scale ตามแนวตั้ง แนวนอนและแนวทแยง 
- Rotate หมุนพื้นที่ที่เลือก 
- Skew ปดเกลียวพื้นที่เลือก 
- Distort การบิดเบือนพื้นที่เลือก 
- Perspective ปรับขนาดของพื้นที่เลือกใหมลีักษณะการมองแบบ Perspective 

(แบบมีมิติ ความกวาง ความยาว ความลึก) 
- Rotate 180? CW หมุน 180 องศา 
- Rotate 90? CW หมุน 90 องศาตามเข็มนาฬิกา 
- Rotate 90? CCW หมุน 90 องศาทวนเข็มนาฬิกา 
- Flip Horizontal กลับจากซายเปนขวา 
- Flip Vertical กลับจากบนลงลาง 

 

การใชงาน Foreground และ Background Color 
 
การใชงานในสวนของ Foreground และ Background Color สามารถทําไดที่สวนของ Toolbox ดังรูป 
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Foreground 

Background 

Switch Color 

Default 

สามารถเปลี่ยนสีไดโดยคลิกที่กรอบ Foreground  หรือ Background จะปรากฏ Color Picker ใหเปลี่ยนสี 
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การใชงาน Type Tool 
 

        สามารถสรางขอความไดทั้งในแนวนอนและแนวตั้ง         การสรางขอความแตละครั้งโปรแกรม Adobe 
Photoshop จะสราง Layer ใหมอัตโนมัติ ลกัษณะของขอความจะมี 2 รปูแบบคือ 
 

1. แบบ Point Type จะมีรูปแบบเปนคําหรืออักษรสั้น ๆ 1 บรรทัด โดยกําหนดจุดเริ่มตนของขอความบน
ชิ้นงาน โปรแกรมจะสราง Type Layer ขึ้นมา และสามารถพิมพขอความลงไปได  
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เม่ือพิมพขอความ
เรียบรอย ใหคลิกที่ปุม          เพื่อตกลง หรือคลิกปุม   

2. แบบ Paragraph Type จะมีรูปแบบเปนขอความที่มีหลายบรรทัด โดยจะอยูภายในขอบเขตที่กําหนด
เดียวกัน (Bounding box) โดยกําหนดจุดขอบเขตของขอความที่ใส โปรแกรมจะสราง Type Layer ขึ้นมา 
และสามารถพิมพขอความและจัดเปน Paragraph ไดจาก Paragraph Palette เม่ือพิมพขอความ
เรียบรอย ใหคลิกที่ปุม          เพือ่ตกลง หรือคลิกปุม  

 
  

ขอความในแนวนอน
ขอความในแนวตั้ง 
ขอความ Selection ในแนวนอน 
ขอความ Selection ในแนวตั้ง 

 
 
 
 
 

 
หากตองการแกไขขอความทีพ่ิมพใหคลิกทีปุ่ม      แลวลากเมาสบนขอความที่ตองการแกไขใหเกิดแถบสี แลว

จึงปรับแกไขขอความ หรอืเปลี่ยนแปลงคุณสมบัติตาง ๆ ของขอความบน Tool options bar เม่ือแกไขเรียบรอยแลวจึง
คลิกปุม  

หากตองการตัวอักษรที่มีลวดลายของภาพ Background เชน                                                    
สามารถทําไดโดยใชสราง Selection ของตัวอักษร ซึ่งมีวิธีใหคลิกที่ปุม        เพือ่เลือก Horizontal Type Mask Tool 
หรือ Vertical Type Mask Tool แลวพิมพขอความที่ชิ้นงาน เม่ือพิมพเสร็จ จะเกิด Selection ที่เปนตัวอักษร จากนัน้
สามารถที่จะคัดลอกลวดลายภาพที่ตองการตาม Selection ของขอความนั้นได 
 
คุณสมบัติตาง ๆ ของ Type Tool 

ชนิดของตัวอักษร ขนาดตัวอักษร การวางตําแหนง

ของขอความ 

รูปแบบตัวอักษร 

ตกแตงขอบ

ตัวอักษร สีตัวอักษร 

Warp Text 

การกําหนดรูป 

แบบตัวอักษร  
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 Warp Text เม่ือคลิกปุม        จะปรากฏ Dialog สําหรับกําหนดคาเพื่อปรับแตงรูปทรงของขอความ 
 

 
 
ตัวอยาง Warp Text 

 
 

การใชงาน Layer 
 

ลักษณะการทํางานของ Layer เปนเหมือนแผนใสวางซอนกันเปนลําดับของรูปภาพ ชวยแยกการทํางานให
ชัดเจน โดยการทํางานแตละครั้งจะมีผลกับ Layer ที่เลือกอยูเทานั้น การมองจะอยูในลกัษณะมองจากดานบนลงมา
ดานลาง วิธีการเรียกใชงาน Layer คลิกที่เมนูคําสั่ง Window ที่แถบ Menu bar เลือกคําสั่ง Show Layer ถาหากพบวา 
Hide Layers แสดงวา Palette Layer ถูกแสดงแลว 
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Active Layer คือ Layer ที่กําลังถูกทํางานอยู สามารถเลอืก Layer ไดจากการคลิกที่แถบ Layer จากนั้นชอง 
Indicates if Layer is จะมีสัญลักษณรูปพูกันปรากฏ หากตองการเคลื่อนยาย Layer โดยให Layer อื่นเคลื่อนยายตาม
ใหคลิกที่ชอง Indicates if Layer is ใหเปนรปูโซเพื่อเชื่อม Layer เขาดวยกัน  

การเปลี่ยนลําดับของ Layer สามารถทําไดโดยคลิกเมาสที่ Layer คางไวแลวลากไปยังลําดับของ Layer ที่
ตองการแลวปลอยเมาส 

ที่ชอง Indicates Layer Visibility หากปรากฏสัญลักษณรูปตาหมายความวา Layer นัน้ถูกแสดงอยู หาก
ตองการซอน Layer ไมใหแสดงผล ใหคลกิที่ชอง Indicates Layer Visibility สัญลักษณรูปตาจะหายไป 

 

Active Layer 

Indicates Layer Visibility 

 
 
 
 
 
 
 

 
 
การสราง Layer 
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ขึ้นใหม ใหคลิกที่ปุม        หากตองการคัดลอก Layer ใหคลิก Layer ที่ตองการแลวปลอย
ลงที่ปุมนี้เชนเดียวกัน แตถาตองการลบ Layer หลังจากคลิกเลือก Layer ที่ตองการแลวใหคลิกที่ปุม  
 

การ Lock Layer 
 

เปนการกําหนดคุณสมบัติตาง ๆ เพื่อบังคับไมให Layer ถูกเปลี่ยนแปลงหรือไดรับผลกระทบใด ๆ มี
ทั้งหมด 4 รูปแบบดังนี ้

 
1. Lock transparent pixels หามไมใหเติมสีหรือปรับแกสีลงไปใน pixels ที่โปรงแสงบน Layer ได 
2. Lock image pixels หามไมใหมีการแกไขหรือตกแตงภาพบน Layer 
3. Lock position หามไมใหมกีารเคลื่อนยายตําแหนงของ Layer  
4. Lock all หามโดยใชการกําหนดคุณสมบัติของทั้ง 3 ขอที่กลาวมา 
 

1 2 3 4 
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การ Merge Layer  
 

เปนการรวมชัน้ของ Layer ต้ังแต 2 ชั้นขึ้นไปมาไวรวมกัน โดยคลิกที่ปุม     แลวจะปรากฏ Dialog 
สําหรับเลือกแบบตาง ๆ ของการ Merge Layer ดังนี ้

 
 
 
 
 
 
 
 
 
 

- Merge Down  Merge Linked  หรือ
เปนการรวม Layer ที่ใชงานอยูกับ Layer ที่อยูลําดับถัดลง โดยถา Layer ที่อยูลําดับถัดไปมีสัญลักษณ
รูปโซ จะมีขอความวา Merge Linked แตหากไมมีรูปโซจะมีขอความวา Merge Down 

- Merge Visible  
เปนการรวม Layer ที่ถูกแสดงหรอืมองเห็นไดทั้งหมด

- Flatten Image  
เปนการรวม Layer ทุกลําดับชั้นเปน Layer เดียว โดยมีชื่อวา Background และจะลบ Layer ที่ถูกซอน
ทิ้งไป 

 
หากตองการเปลี่ยนชื่อของ Layer ใหคลิกเลือก Layer Properties จะปรากฏ Dialog ของ Layer ซึ่ง

สามารถเปลี่ยนชื่อของ Layer ได และแถบสีได
 

 
 
การจัด Set ของ Layer 
 

 เปนการรวบรวม Layer ตาง ๆ มาไวเปนกลุม Layer Set สามารถใชคําสั่งตาง ๆ เหมือน Layer ทั่ว 
ไป เชน การดู คัดลอก เคลื่อนยาย และการเปลี่ยนลําดับ ยกเวนคําสั่งบางคําสั่ง เชน Layer Effect ดงันั้นใช
งานคําสั่งใด ๆ ของ Layer Set จะเกิดขึ้นกับ Layer ภายในทุก Layer 
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 การสราง Layer Set คลิกที่ปุม          เพือ่สราง Set หลังจากนั้นใหคลิกเลือก Layer ที่ตองการ
จัดเก็บคางไว แลวลากที่ Layer Set จากนั้นใหปลอยเมาส 

 
หากดับเบ้ิลคลิกที่ Layer Set จะปรากฏ Dialog ของ Layer Set Properties ซึ่งสามารถเปลี่ยนชื่อของ Layer  

                                                             Set ได และแถบสีได 
 
 
 
 
 
 
 
 

 

การทําภาพโดยใช Filter 
 

 ฟลเตอร (Filter) คือการตกแตงภาพดวยเทคนิคพิเศษ ที่สามารถปรับเปลี่ยนรูปแบบของภาพตามความ
ตองการของงาน เราสามารถใชงาน Filter ไดโดยเลือก Menu > Filter > เลือกใช Filter ที่ตองการ 

 

ตัวอยางการใช Filter 
ที่ Menu Bar จะมีปุม Filter(1) อยู เม่ือกดแลวจะมี Filter Menu ปรากฏขึ้นเลื่อนเมาสไปยัง Filter 

“Blur”(2) จะมีเมนูยอยเพิ่มขึน้มา ใหกดเลือกที่ “Redial Blur”(3) 
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เม่ือเลือกเสร็จแลวจะปรากฏหนาจอการปรบัเปลี่ยนลักษณะของ Filter สามารถที่จะกําหนดไดตามตองการ 
(ใน Filter แตละตัวนั้น หนาจอการปรับเปลี่ยนลักษณะของ Filter จะไมเหมือนกนั) เสร็จแลวกดปุม OK เพื่อจบขั้นตอน
การทํางานของ Filter 

 

 
 

จะไดภาพที่มีการตกแตงดวย Filter: Radial Blur ออกมา ทัง้นี้ ถาใช Filter อื่นรูปงานที่ปรากฏ จะตางกันออกไป 
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ตัวอยาง Filter ที่นาสนใจ  
 

 

 
ภาพตนแบบ 

 

 
Smudge Stick 

 

 
Gaussian Blur 

 

 
Radial Blur 

 

 
Angled Strokes 

 

 
Mosaic 

 

 
Facet 

 

 
Fragment 

 

 
Lens Flare 

 

 
Lighting Effects 

 

 
Sharpen 

 

 
Graphic Pen 

 

 
Halftone Pattern 

 

 
Stamp 

 

 
Water Paper 

 

 
Wind 
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การใชงาน Layer Style 
 

คลิกที่เมนู Layer > Layer Style > Blending Options จะปรากฏหนาตางดังภาพขางลาง 
 

 
 

(1) คือ Style ที่ตองการใชกับ Layer ที่เราเลือกไว จะมีใหเลือก 10 แบบจากบนลงลาง 
(2) คือ การกําหนดคาตางๆ ของแตละ Style ซึง่จะแตกตางกันไปในแตละ Style 

 
ตัวอยางการใช Layer Style 
 

 
Drop Shadow 

 
Inner Shadow 

 
Outer Glow 

 
Inner Glow 

 
Bevel and Emboss 

 
Satin 

 
Gradient Overlay 

 
Pattern Overlay 

 
Stroke 
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การเปลี่ยนรูปรางของรูป (Transform) 
 
เราสามารถเปลี่ยนแปลง Layer ในรูปแบบตางๆไดเชน การยอ/ขยาย การหมนุภาพ การบิดภาพ ดวยคําสั่ง 

Transform โดยคลิกเลือก Edit > Transform > (เลือก Transform Function ที่ตองการ) 
 

ลักษณะของ Transform 
 

 
ภาพตนแบบ 

 
Scale 

 
Rotate 

 
Skew 

 
Distort 

 
Perspective 

 
 

การปรับคาความสวาง/ความคมชัด (Brightness/Contrast) 
 
การปรับความสวาง-ความมืดของภาพ และการตัดกันของสีที่ชัดเจนขึ้นนัน้ สามารถทําไดโดยใชคําสั่ง 

Brightness/Contrast โดยเลือกคลิกที่ Image > Adjust > Brightness/Contrast 
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Original 

 
Brightness 

 
Contrast 

               
                    

การปรับขนาดของชิ้นงาน  
 

Image Size 
Image Size คือการ ลด/ ขยายรูปภาพโดยสามารถใชคําสั่งนี้ไดจากเมนู Image > Image Size… 

จะปรากฏหนาตางที่ใหเรากําหนดขนาดของภาพขึ้นมาดังรูป 
 

               
 

(1) Width(กวาง) และ Height(สูง) ของรูปภาพ สามารถกําหนดไดตามตองการ โดยมีหนวยให
เลือกสองแบบคือ Pixel และ % 

(2) Constrain Proportions Sign เม่ือสัญลักษณนี้ปรากฏดังรูป แสดงวาเมื่อเราไดกําหนดขนาด
ภาพไวดานใดดานหนึ่งแลว โปรแกรมจะกําหนดสัดสวนของดานที่เหลือใหเอง(อัตราสวนที่เทากัน) ผลที่ไดก็คือ 
ไมวาจะยอหรอืขยาย รูปภาพที่ออกมาก็จะมีอัตราสวนของ กวาง x สูงเทาเดิม 

(3) Constrain Proportions Check Box จาก (2) เม่ือเราไมตองการ ยอ/ขยาย รูปภาพให
เหมือนอัตราสวนเดิมใหคลิกที่ Check Box ออก เครือ่งหมาย  จะหายไปหลังจากนัน้การกําหนดขนาด กวาง
และสูงสามารถกําหนดไดตามตองการ 

 
 
Training Service (ICT Center) 
 



เอกสารประกอบการอบรมเทคนิคการสรางและตกแตงภาพดวย Adobe Photoshop CS3           หนาท่ี 31 

 

Canvas Size 
การ Canvas Size คือการลด/ ขยายพื้นทีรู่ป โดยเพิ่มพืน้ Background และสามารถขยายรูปโดย

กําหนดทิศทางได ดังรูป 
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ตัวอยางการ Canvas Size 

 

 
 

พื้นที่ที่เพิ่มจากการ 

Canvas 

1. Current Size ขนาดปจจุบันของงาน 

2. New Size ขนาดที่เพิ่มขึ้นจากขนาดของงาน 

3. Relative เปนคุณสมบัติบอกคาขนาดของ New Size 

เครื่องหมาย  คาในชอง Width และ Height จะเปน 0 

สามารถเพิ่มพื้นที่งานโดยไมตองรวมคา Current Size  

4. Anchor ที่ทางที่ตองการเพิ่มขนาดใหไปในทิศทางที่

ตองการ 

1 

2 

3 

4 
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การตัดกรอบของรูป (Crop) 
 
 การ Crop คือ การตัดกรอบภาพเอาเฉพาะที่ตองการ นอกจากรูปภาพจะมีขนาดเล็กเกินไปแลว บางครั้ง
รูปภาพก็มีขนาดใหญเกินไปไดเชนกัน เราสามารถตัดกรอบภาพ (Cropping) ใหเหลือเฉพาะที่ตองการไดโดยใช
เครื่องมอืสองชนิดนี้ ดังนี ้
 

วิธีที่ 1 การตัดกรอบภาพโดยเครื่องมือ Rectangular Marquee Tool 
1. เลือกเครื่องมือ                  บนแถบเครือ่งมือและกําหนด Feather ใหเทากับ 0 กอน 
2. สราง Selection ที่ภาพในสวนที่ตองการตัดกรอบ  
3. เลือกเมนู Image -> Crop จะไดรูปจากการ Cropping  

 
วิธีที่ 2 การตัดกรอบภาพโดยเครื่องมือ Crop 
1. เลือกเครื่องมือ                 บนแถบเครือ่งมือ 
2. สรางพื้นที่ที่ตองการตัดกรอบภาพ สังเกตวาจะเกิดแถบสีเทาขึ้นบริเวณรอบนอกขอบกรอบที่สรางขึน้มา 

บริเวณสีเทาคือ บริเวณของรปูภาพที่ถูกตัดทิ้งนั่นเอง 
3. ปรับแตงพืน้ทีท่ี่เลือก 
4. คลิกปุม            เพือ่ยืนยนัการตัดกรอบรปูตามตองการ (กรณียกเลิกใหคลิกปุม         แทน) 

 
ตัวอยางการ Cropping 
 

ภาพกอนการ Cropping 
 

ภาพหลังการ Cropping 
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